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Introducing Adobe Acrobat 3.0

 

elcome to the Adobe Acrobat pro-
gram—the fastest way to publish any 
document on your corporate intranet, 

the World Wide Web, or CD-ROM. You use Adobe 
Acrobat to create, enhance, and read Portable 
Document Format (PDF) documents.

You create PDF documents by converting elec-
tronic documents or scanning printed documents. 
Converted PDF documents maintain the look and 

layout of the original and can be viewed on any 
type of computer—Windows, Macintosh, UNIX, 
or OS/2.

You enhance PDF documents by adding interac-
tivity such as links, forms, and movies. You can 
make pinpointing information fast by providing 
full-text indexes for PDF document collections.

Readers of the PDF documents you publish use 
Acrobat viewers or Web browsers to view the PDF 
documents. You can distribute Acrobat Reader, 
one of the Acrobat viewers, without charge.
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Create PDF

• Convert PostScript with 
Acrobat Distiller
• Convert scanned or imported 
images with Acrobat Capture
• Print to PDF files with the       
PDF Writer driver

Enhance PDF

• Create links, forms, and other 
interactivity with Acrobat Exchange
• Link Web pages and other 
PDF documents
• Generate full-text indexes with 
Acrobat Catalog

Read PDF

• Search for PDF documents on the 
Web, network servers, or CD-ROMs
• Read PDF in Acrobat Reader or 
Exchange, or in a Web browser
• Print PDF for reading off line
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About this guide

 

Before you begin using Adobe Acrobat, be sure to 
read this guide for installation instructions, tips on 
improving performance, and other important 
information. This guide contains

 

•

 

System requirements

 

•

 

Registration and Adobe product and service 
information

 

•

 

Instructions for installing Adobe Acrobat

 

•

 

Instructions for installing the Adobe printer 
driver

 

•

 

Tips on improving performance

 

•

 

Instructions for installing the Adobe Type 
Manager (ATM) utility

 

System requirements

 

Adobe Acrobat requires certain hardware and soft-
ware components to run. To use Adobe Acrobat, 
you need

 

Windows 3.1 and later or Windows 95:

 

•

 

386, 486, or Pentium processor-based personal 
computer

 

•

 

Microsoft Windows 3.1 or later, or Windows 95

 

•

 

8 MB of RAM for Acrobat Reader

 

•

 

8 MB of RAM for Acrobat Exchange

 

•

 

8 MB of RAM for Acrobat Catalog

 

•

 

16 MB of RAM for Acrobat Distiller

 

•

 

16 MB of RAM for Acrobat Capture plug-in 
(requires 486 or Pentium processor-based 
personal computer)

 

•

 

CD-ROM drive (1.44 MB floppy disks avail-
able—send in your fulfillment card)

 

Windows NT 3.5.1 and later:

 

•

 

386, 486, or Pentium processor-based personal 
computer

 

•

 

Windows NT 3.5.1, Windows NT 4.0, or later

 

•

 

16 MB of RAM for Acrobat Reader

 

•

 

16 MB of RAM for Acrobat Exchange

 

•

 

16 MB of RAM for Acrobat Catalog

 

•

 

24 MB of RAM for Acrobat Distiller

 

•

 

24 MB of RAM for Acrobat Capture plug-in 
(Windows NT 3.5.1 only; requires 486 or Pentium 
processor-based personal computer)

 

•

 

CD-ROM drive (1.44 MB floppy disks available 
via fulfillment)

 

Macintosh 68020 – 68040:

 

•

 

3.5 MB of RAM available to Acrobat Reader

 

•

 

4 MB of RAM available to Acrobat Exchange

 

•

 

6 MB of RAM available to Acrobat Catalog

 

•

 

6 MB of RAM available to Acrobat Distiller

 

•

 

Capture Plug-in not available

 

•

 

Apple system software 7.0 or later

 

•

 

CD-ROM drive (1.44 MB floppy disks available 
via fulfillment)
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Power Macintosh:

 

•

 

5 MB of RAM available to Acrobat Reader

 

•

 

6 MB of RAM available to Acrobat Exchange

 

•

 

8 MB of RAM available to Acrobat Catalog

 

•

 

8 MB of RAM available to Acrobat Distiller

 

•

 

16 MB of RAM available to Acrobat Capture 
plug-in

 

•

 

Apple system software 7.0 or later

 

•

 

CD-ROM drive (1.44 MB floppy disks available 
via fulfillment)

 

Web browser requirements:

 

To read PDF files in a Web browser, you need one 
of the following:

 

•

 

Netscape Navigator 3.0 or later compatible 
browser

 

•

 

Internet Explorer 3.0 or later compatible 
browser

For information about using Netscape Navigator 
2.0 with Adobe Acrobat, see the Acrobat Exchange 
ReadMe file. 

See “Improving Performance” on page 18 for tips 
about maximizing Acrobat performance and sug-
gestions for reducing memory requirements. 

 

Registration

 

Please register your copy of Adobe Acrobat, so 
Adobe can continue to provide you with the high-
est-quality software, offer technical support, and 
keep you informed of new Adobe Acrobat software 
developments.

 

 

 

To register, return the enclosed reg-
istration card or register online. 

 

If you have a modem, you can register online at the 
end of the installation process or at a later date. 
Follow the on-screen instructions to register at the 
end of the installation process. 

 

To register at a later date:

 

1

 

Follow the instructions for your platform:

 

•

 

In Windows, open the Acrobat3/Register folder 
in File Manager (Windows 3.1 and later and 
Windows NT 3.5.1) or Windows Explorer 
(Windows 95 or Windows NT 4.0).

 

•

 

On a Macintosh, open the Register folder inside 
the Adobe Acrobat 3.0 folder.

 

2

 

Double-click the register.exe file (Windows) or 
the Adobe Acrobat Registration icon (Macintosh).

 

3

 

Follow the on-screen instructions to complete 
the registration. 

 

About Adobe products and 
services

 

More information about Adobe products and ser-
vices is available through the following services:

 

•

 

The Adobe Home Page on the World Wide Web. 
To open the Adobe Home Page, use the URL 
http://www.adobe.com.

 

•

 

Forums on CompuServe and America Online. 
Forums and availability may vary by country. 

 

•

 

Adobe’s own technical support bulletin board 
system. Install the First Class Software from the 
Adobe Acrobat 3.0 CD-ROM in the Solu-
tions/Online folder; then use your modem to call 
206-623-6984. 
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•

 

FaxYI, a free fax-based service that provides the 
latest technical information about Adobe prod-
ucts. To use FaxYI, call 206-628-5737. This service 
is available 24 hours a day, 7 days a week. 

 

•

 

To speak with an Adobe customer service repre-
sentative, call 800-833-6687.

 

•

 

When you register your retail product purchase, 
you receive 90 days of free technical support from 
the date of your first call. When you register your 
upgrade purchase, you receive 30 days from the 
date of your first call.To contact Adobe Acrobat 
technical support, call 206-628-2746 (Windows), 
206-628-2745 (Macintosh), or 206-628-3950

 

 

 

(UNIX). See Troubleshooting in the Acrobat 
Online Guide for more information.

 

•

 

Using electronic mail, you can order technical 
and customer service information about Adobe 
products on Macintosh, Windows, and UNIX 
platforms.The information is created by Adobe 
Technical Support and can help you with trouble-
shooting a problem or help you learn new ways to 
use your Adobe product. To get started, send an 
email message to “techdocs@adobe.com” with 
“help” in the Subject field. Email from Adobe 
“techdocs” is available 24 hours a day, 7 days a 
week.

 

The Adobe Acrobat package 
contents

 

The Adobe Acrobat software package includes the 
following software and documentation:

 

•

 

The Adobe Acrobat CD-ROM (For a description 
of its contents, see the following section, “Contents 
of the Adobe Acrobat CD-ROM.”)

 

•

 

The Adobe Acrobat Reader CD-ROM (For a 
description of its contents, see the following 
section, “Contents of the Adobe Acrobat Reader 
CD-ROM.”)

 

•

 

Adobe Acrobat Getting Started

 

•

 

Registration card

 

•

 

Floppy disk fulfillment card

 

Contents of the Adobe Acrobat 
CD-ROM

 

The Adobe Acrobat CD-ROM contains the 
following:

 

The Adobe Acrobat software 

 

This software 
includes the installer, the Adobe Acrobat compo-
nent programs, plug-in modules, the Adobe 
printer driver, and the Adobe Type Manager util-
ity. For more information, see “Components of 
Adobe Acrobat 3.0” on page 6.

 

Adobe Acrobat Online Guides 

 

The Acrobat Online 
Guide includes the Acrobat Exchange, Distiller, 
PDF Writer, Catalog, Search, Capture plug-in, and 
Scan Guides. These documents are the complete 
Adobe Acrobat documentation, optimized for 
online use. See “Using the Acrobat Online Guides” 
on page 5 for more information.

 

Adobe Acrobat Tutorials

 

The Acrobat Tutorials are 
brief QuickTime movies that demonstrate Acrobat 
uses and features with accompanying step-by-step 
instructions.

 

Adobe Technical Notes

 

These files, written by 
Adobe staff, provide technical information for 
advanced users.
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Electronic Publishing Guide

 

This document pro-
vides an introduction to electronic publishing and 
the issues involved in creating online documents 
and presentations.

 

Clip art and sounds

 

You can use the clip art and 
sounds to enhance your PDF documents in 
Exchange.

 

Demonstration versions of other Adobe products

 

These tryout versions of Adobe flagship products 
give you a taste of creating images, illustrations, 
presentations, and page layouts with Adobe prod-
ucts.

 

Contents of the Adobe Acrobat 
Reader CD-ROM

 

The Adobe Acrobat Reader CD-ROM contains the 
following:

 

The Adobe Acrobat Reader software

 

The Reader 
software includes Acrobat Readers for all plat-
forms available and the Adobe printer driver. 

 

The AcroCafé

 

You are invited to hang out in the 
AcroCafé, browse the sample files, and learn the 
newest techniques for making the most of Adobe 
Acrobat.

You are free to distribute the Acrobat Reader 
installers on the Acrobat Reader CD-ROM. You 
can distribute them on your Web site and bulletin 
board, or on CD-ROMs and floppies you create.

You may make and distribute unlimited copies of 
the Acrobat Reader software, including copies for 
commercial distribution, as long as each copy that 
you make and distribute includes the following:

 

•

 

Acrobat Reader installer, exactly as provided by 
Adobe;

 

•

 

Acrobat Reader Electronic End User License 
Agreement;

 

•

 

Copyright and other proprietary notices 
included in Acrobat Reader; and

 

•

 

The following attribution statement on any 
media and packaging that includes Acrobat 
Reader:

“Acrobat® Reader Copyright © 1987-1996 Adobe 
Systems Incorporated. All rights reserved. Adobe 
and Acrobat are trademarks of Adobe Systems 
Incorporated which may be registered in certain 
jurisdictions.”

The Acrobat Reader Electronic End User License 
Agreement and proprietary notices are contained 
in the Reader installer program. You are expressly 
prohibited from modifying or creating your own 
installer for the Acrobat Reader software. Details 
on the terms of use for the Acrobat Reader prod-
ucts are found in the Acrobat Reader Electronic 
End User License Agreement presented during 
installation of each product.

A special “Includes Adobe Acrobat” logo is 
available from Adobe for use when distributing 
Acrobat Reader. See http://www.adobe.com/
acrobat/acrodist.html for more details.

 

Using the Acrobat Online Guides

 

If you don’t know which Acrobat component is 
used for the task you need information about, 
open Acrobat Exchange and choose Acrobat 
Online Guide from the Help menu (Windows) or 
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from the Balloon Help menu ( ) (Macintosh). 
The table of contents for the guide will lead you to 
the right information.

If you know what Acrobat component is used 
for the task you need information about, choose 
the guide for that component from the Help or 
Balloon Help menu.

If you need help with the component you are 
using, Acrobat Exchange, Distiller, or Catalog, 
choose that guide from the Help menu (Windows) 
or the Balloon Help menu (Macintosh). 

The Acrobat Online Guide has two types of 
indexes: a traditional book-type index, and a full-
text index generated by Acrobat Catalog. With the 
traditional index, clicking a term takes you to the 
main discussion of that item in the guide. When 
you search for a term in the guide’s full-text index, 
you go to the first occurrence of the term in the 
guide and can go on to as many other occurrences 
as you need to.

To go to the traditional index, click Index in the 
table of contents or click the index icon ( ) at the 
top of any page in the guide. Use the search tool 
(

 

v

 

) or Search command in Acrobat Exchange to 
search the full-text index. For information about 
using the search tool or command, see the Search 
Online Guide.

 

Components of Adobe 
Acrobat 3.0

 

Adobe Acrobat 3.0 works as an integrated set of 
programs:

 

•

 

Acrobat Distiller converts PostScript files to PDF 
documents. Acrobat PDF Writer is a printer driver 
that “prints” PDF files with the standard applica-
tion Print command. Use Distiller with complex 
page layout documents, or with documents that 
contain Encapsulated PostScript (EPS) graphics or 
images that you need to compress and resample 
precisely. Use PDF Writer for fast conversion of 
simple business documents to PDF.

 

•

 

The Capture Pages command in Acrobat 
Exchange also creates PDF documents, by 
converting imported images and scanned 
paper documents. The Scan command in 
Exchange is used with the scanner.

 

•

 

Acrobat Catalog creates full-text indexes of PDF 
document collections that can be searched using 
the search query tool in Exchange and Reader.

 

•

 

Acrobat Exchange is an Acrobat viewer that lets 
you modify PDF documents, giving them state-of-
the-art electronic document features such as pass-
word protection, annotations, links and book-
marks, thumbnails, movies and sound, and inter-
active forms. Use the Capture Pages command to 
create PDF documents by converting imported 
images and scanned paper documents. You can 
also use Exchange for simple text editing, and for 
correction of captured files.

 

•

 

Another PDF document viewer, Acrobat Reader, 
is available for free on all platforms. 

See the online guides for information about 
creating, viewing, modifying, and indexing 
PDF documents.
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ACROBAT ONLINE GUIDES, TUTORIALS, AND ELECTRONIC PUBLISHING GUIDE

 

The online guides, tutorials, and 
Electronic Publishing Guide contain all the information you need to help you get the most out of Adobe Acrobat 3.0.

The guide to Acrobat publishing on the World Wide Web or CD-ROM

C
 o

 n
 t

 e
 n

 t
 s

New PDF display optionsThe following new features provide more control 

over the display of PDF documents on-screen.
• New options enable documents to be opened with 

settings suitable for online tutorial, help, and kiosk 

applications. Options include Hide Toolbar, Hide 

Menubar, Center Window On Screen, and Resize Window 

to Initial Page.
• New continuous and continuous-facing page layout 

modes enable continuous scrolling between pages.
• Calibrated color Grayscale and color images are 

automatically adjusted for the user’s display to provide 

more accurate display between different monitors and 

systems. Exchange uses ColorSynch on Macintosh 

systems and ICC profiles on Windows systems; if either 

are not present, a default monitor profile is used.
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• New Features

• Tools, commands, and screen 

elements

• Using Acrobat Exchange

• Using Acrobat Exchange

• Modifying PDF documents

• Converting image files to PDF

• Using PDF on the Web

• Incorporating PDF documents 

in OLE documents (Windows 

and Macintosh)

• Troubleshooting

• Index

Adobe™  Acrobat™  Exchange 3.0

Online Guide
Quickly find the answers to your 
“how to” and troubleshooting 
questions in the Acrobat Online Guides. 

Electronic Publishing Guide
Read the Electronic Publishing Guide and the sample  
files to learn about publishing with Adobe Acrobat
on CD-ROM and the World Wide Web. Visit the 
Acrobat Web site (http://www.adobe.com/acrobat) 
for the latest on the electronic publishing revolution.

Tutorial
Watch the tutorial movies and work through 
the step-by-step instructions to learn to use 
the powerful features of Adobe Acrobat to 
create effective electronic documents.

TRAVELS TO INDIA
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Top Gear for Tough Travel
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Installing and Starting Adobe Acrobat 
in Windows 

his section explains how to install, start, and 
uninstall the software included in the Adobe 
Acrobat software package.

Use the following procedure to install the Adobe 
Acrobat program files from the CD-ROM disc. 
Note that you cannot run the Adobe Acrobat com-
ponents from the CD-ROM; you must install the 
components onto your hard disk.

If you are upgrading from Adobe Acrobat 2.1 or 
earlier, the installer creates a new folder containing 
new Adobe Acrobat files. Your copies of Adobe 
Acrobat Exchange, Distiller, and Catalog 2.1 are 
not affected. Acrobat PDF Writer 2.1 will be 
replaced by PDF Writer 3.0.

To install Adobe Acrobat:

1 Restart Windows and do not start any other appli-

cations.

2 Insert the Adobe Acrobat CD-ROM disc into 
your CD-ROM drive.

3 Follow the instructions for your platform:

• In Windows 3.1 or later, and Windows NT 3.5.1, 
choose the Run command from the File menu in 
Program Manager.

• In Windows 95 or Window NT 4.0, choose the 
Run command from the Start Menu.

4 Type d:\install.exe (where d: is the 
CD-ROM drive indicator) and click OK.

5 The Adobe Acrobat Installer dialog box appears. 
Follow the instructions on-screen to progress 
through the introduction, accept the license agree-
ment, and initially select the products you want 
to install. The Select Adobe Acrobat and Related 
Products dialog box displays the default selection 
of products to install. 

6 The Select Components dialog box displays the 
amount of disk space required to install each set of 
program files, the total amount of disk space 
needed for the selected files, and the amount of 
disk space available. Do one of the following:

• Select the components you want to install.

• Deselect any components you do not want to 
install. 

• Accept the selected components.

Note: The Capture plug-in requires Exchange 
and PDF Writer. If you select the Acrobat Capture 
plug-in, you must also select Acrobat Exchange Files 
and PDF Writer Files or already have them installed.

7 Choose one of the two options:

• Accept the default target drive and folder 
displayed in the Destination Directory box.

T
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• Click Browse and type a folder, a new drive, or 
both.

Note: Click the Disk Space button to display 
available disk space information about available 
hard drives.

8 The Choose Scanner Device dialog box displays 
the ISIS drivers supplied with the Acrobat Scan 
plug-in. Do one of the following:

• Select all the drivers that match the scanners that 
you plan to use.

• Click Select All.

Note: If your scanner does not appear in the list, you 
can use your scanner-supplied TWAIN driver. Your 
TWAIN driver will appear in the list when you setup 
up your scanner in Exchange. See the Scan Plug-in 
Online Guide for details.

9 Click Next.

10 In the User Information box, enter your name, 
your organization (optional), and the serial 
number for your program. Your serial number is 
located on the registration card and on the inside 
cover of this guide.

11 Click Next to begin the installation.

12 Follow the on-screen instructions. When 
installation is complete, a message appears indi-
cating that the installation was successful.

13 To register the application online, click 
Electronic Registration, and then follow the
on-screen instructions.

Installing QuickTime
QuickTime is needed to play QuickTime movies 
pointed to from PDF documents. You can install 
QuickTime from the Adobe Acrobat CD-ROM.

To install QuickTime:

1 Insert the Adobe Acrobat CD-ROM disc into 
your CD-ROM drive.

2 Open the QuickTim folder.

3 Open the Readme file contained in this folder 
and follow the installation instructions in the file.

Setting up Distiller Assistant
Distiller Assistant makes it possible to print 
directly to Acrobat Distiller so that you can create 
PDF files in one easy step. During Distiller instal-
lation, Distiller Assistant is installed in your 
Startup or Start folder. If you need to set up 
Distiller Assistant in Windows 3.1 or later, or 
Windows 95, after installation follow the instruc-
tions for manual installation in this section. See 
the Readme for Windows NT manual installation 
instructions.

To use Distiller Assistant, you need more than 20 
MB of application RAM. You need approximately 
20 MB of RAM to run Distiller, Distiller Assistant, 
and Exchange or Reader, plus the amount of RAM 
needed to run the application the document was 
created in. If you do not have enough RAM, then 
setup is not necessary.
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To set up Distiller Assistant:

1 Follow the instructions for your platform:

• In Windows 3.1 or later, drag the Distiller 
Assistant program icon to the Startup group.

• In Windows 95, drag the Distiller Assistant 
program icon to the Win95/Start Menu/Programs/
StartUp folder.

2 Restart Windows. Dragging Distiller Assistant 
to the StartUp group or folder ensures that 
Distiller Assistant is launched and active at every 
startup.

Starting Adobe Acrobat 
programs 
To use Adobe Acrobat, you must have installed the 
files from the CD-ROM disc onto your hard drive 
or network server. You cannot run Adobe Acrobat 
from your CD-ROM drive.

To start Acrobat Exchange, Distiller, or Catalog:

1 Follow the instructions for your platform:

• In Windows 3.1 or later, or Windows NT 3.5.1, 
open the Adobe Acrobat group in Program 
Manager, and double-click the program icon you 
want to start.

• In Windows 95 or Windows NT 4.0, click 
the Start Menu and choose Programs > Adobe 
Acrobat; then click the program name of the 
application you want to start.

To start Acrobat Exchange without plug-ins:

Hold down the Shift key immediately after you 
launch the Exchange program.

Uninstalling Adobe Acrobat
You can remove all of the Acrobat components you 
installed, except for PDF Writer, with the Uninstall 
utility.

To uninstall Adobe Acrobat components:

1 Follow the instructions for your platform:

• In Windows 3.1 or later, or Windows NT 3.5.1, 
open the Adobe Acrobat Group, double-click the 
UnInstall Adobe Acrobat icon, and click Yes to 
confirm removing Acrobat. Follow the on-screen 
instructions.

• In Windows 95 or Windows NT 4.0, click the 
Start Menu and choose Settings > Control Panel. 
Double-click the Add/Remove Programs Control 
Panel. Select Adobe Acrobat 3.0, click 
Add/Remove, and click OK to confirm removal. 
Follow the on-screen instructions.

To remove PDF Writer:

1 Follow the instructions for your platform:

• In Windows 3.1 or later, or Windows NT 3.5.1, 
open the Printers Control Panel, select PDF Writer 
on Disk, click Remove, and click Yes to confirm 
removal.

• In Windows 95, click the Start Menu and choose 
Settings > Printers. Right-click Acrobat PDF 
Writer, select Delete from the menu, and click Yes 
to removing PDF Writer and associated files.

Note: PDF Writer is not available for Windows 
NT 4.0.
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Installing Adobe Acrobat on the 
Macintosh

his section explains how to install, start, and 
uninstall the software included in the Adobe 
Acrobat software package.

Use the following procedure to install the Adobe 
Acrobat program files from the CD-ROM disc. 
Note that you cannot run the Adobe Acrobat 
program from the CD-ROM; you must install 
the program onto your hard disk.

If you are upgrading from Adobe Acrobat 2.1 or 
earlier, the installer creates a new folder containing 
new Adobe Acrobat files. Your copies of Adobe 
Acrobat Exchange, Distiller, and Catalog 2.1 are 
not affected. Acrobat PDF Writer 2.1 will be 
replaced by PDF Writer 3.0.

To install Adobe Acrobat:

1 Insert the Adobe Acrobat CD-ROM disc into 
your CD-ROM drive.

2 Double-click the Install Adobe Acrobat 3.0 icon.

3 The Adobe Acrobat Installer dialog box appears. 
Follow the instructions on-screen to progress 
through the introduction and accept the license 
agreement.

4 From the Install Adobe Acrobat dialog box, set 
up how you want to install the Adobe Acrobat 
program:

•  Choose Easy Install to install Acrobat Distiller, 
Exchange, PDF Writer, Catalog, and several plug-
ins in the Adobe Acrobat folder on your destina-
tion disk.

• To select individual items for installation, choose 
Custom Install from the pop-up menu, and select 
the items you want to install.

5 To specify where to install the program, click the 
Select Folder button, and use the standard dialog 
box to select a location.

6 Click Install, and follow the on-screen instruc-
tions. When installation is complete, a message 
appears indicating that the installation was 
successful.

7 To register the application online, click 
Electronic Registration, and then follow the 
on-screen instructions.

8 Click Restart to restart your computer. 

T
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Setting up Distiller Assistant
Distiller Assistant makes it possible to print 
directly to Acrobat Distiller so that you can create 
PDF files in one easy step. Distiller Assistant is 
installed during the Acrobat default install process. 
To use Distiller Assistant, you need more than 20 
MB of application RAM. You need approximately 
20 MB of RAM to run Distiller, Distiller Assistant, 
and Exchange or Reader, plus the amount of RAM 
needed to run the application the document was 
created in.

If you want to use the Acrobat Distiller Assistant 
on the Macintosh, you need to install the Adobe 
PostScript Printer Driver 8.3.1, available on the 
Adobe Acrobat 3.0 CD-ROM. See page 22 for 
printer driver installation instructions. 

Customizing the Acrobat 
Exchange installation
If you want to limit the Exchange plug-ins that get 
installed on your system or install ATM at the sys-
tem level, you need to run the Acrobat Exchange 
3.0 installer instead of the Adobe Acrobat 3.0 
installer.

To custom install Acrobat Exchange:

1 Insert the Adobe Acrobat CD-ROM disc into 
your CD-ROM drive.

2 Open the Exchange folder inside the Adobe 
Acrobat 3.0 folder.

3 Double-click the Exchange 3.0 installer icon.

4 The Exchange Installer dialog box appears. 
Follow the instructions on-screen to progress 
through the introduction and accept the license 
agreement.

5 Choose Custom Install from the pop-up menu, 
and select the items you want to install.

6 To specify where to install the program, click the 
Select Folder button, and use the standard dialog 
box to select a location.

7 Click Install, and follow the on-screen instruc-
tions. When installation is complete, a message 
appears indicating that the installation was 
successful.

8 Click Restart to restart your computer.

Installing QuickTime
QuickTime is needed to play QuickTime movies 
pointed to from PDF documents. QuickTime is 
installed on most Macintosh computers, but if you 
need it, you can install it from the Adobe Acrobat 
CD-ROM.

To install QuickTime:

1 Insert the Adobe Acrobat CD-ROM disc into 
your CD-ROM drive.

2 Open the QuickTime folder.

3 Open the Readme file contained in this folder 
and follow the installation instructions in the file.
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Installing the OLE plug-in
Install the Object Linking and Embedding (OLE) 
plug-in if you need to view PDF documents 
embedded as OLE objects in other application 
files. The OLE plug-in installer program also 
installs the necessary OLE system files in your 
System Folder.

To install the OLE plug-in:

1 After installing Adobe Acrobat on your hard 
drive, open the OLE folder inside the Adobe 
Acrobat 3.0 folder on the CD-ROM.

2 Double-click the Install OLE plug-in icon.

3 Follow the on-screen instructions. When instal-
lation is complete, a message appears indicating 
that the installation was successful.

Starting Adobe Acrobat 
programs
To use Adobe Acrobat, you must have installed the 
files from the CD-ROM disc onto your hard drive 
or network server. You cannot run Adobe Acrobat 
from your CD-ROM drive.

To start Acrobat Exchange, Distiller, or Catalog:

Open the Adobe Acrobat 3.0 folder, and double-
click the program icon of the application you want 
to start.

To start Acrobat Exchange without plug-ins:

Hold down the Shift key immediately after you 
double-click the Exchange program icon.

Uninstalling Adobe Acrobat
You can remove all the Acrobat components you 
installed with the following procedure.

To uninstall Adobe Acrobat components:

1 Drag the Adobe Acrobat 3.0 folder to the trash.

2 Open your System Folder and drag DistAsst-
Daemon and the Acrobat Search Resources folder 
to the trash. 

3 Open the Control Panels folder in the System 
Folder and drag PDF Writer Shortcut to the trash. 

4 Open your Preferences folder in your System 
folder. Drag the Acrobat component preferences 
files to the trash.

5 Open your Extensions folder in your System 
folder and drag the Acrobat PDF Writer file to the 
trash.

6 Open your Printer Description folder in your 
Extensions folder and drag DistAsst and Acrobat 
Distiller (PPD) to the trash.

7 Empty the trash.
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What’s New in Adobe Acrobat 3.0

ersion 3.0 of Adobe Acrobat includes new 
PDF creation and viewing features, such as 
the ability to compress Type 1 fonts and 

add interactive form fields, along with a number of 
new options and tools.

Enhanced creation features
Adobe Acrobat 3.0 has improved its ability to com-
press images and fonts, streamline the creation 
process on the Macintosh, and control printing-
specific information.

Automatic orientation Most landscape pages are 
oriented to a landscape position in Distiller for 
correct display in Acrobat Exchange or Reader.

Automating Document Info field entry Distiller will 
automatically include certain Document 
Structuring Comments (DSC) information found 
in a PostScript file as Document Info field data. 
The DSC comments For, Title, and Creator are 
converted to Author, Title, and Creator Document 
Info fields, respectively.

Distiller Assistant Distiller Assistant, the utility 
that makes it easy to create a PDF file with Distiller 
in one step, is now available on the Macintosh.

Font subsetting Distiller allows you to set the char-
acter threshold that determines when to subset a 
font to reduce file size. PDF Writer subsets fonts 
when less then 25% of the characters in a font are 
used in a document.

Compressing fonts Distiller and PDF Writer use 
the new compressed Type 1C font format to 
reduce file size when 3.0 compatibility is chosen. 
Type 1C fonts reduce file size by compressing 
Type 1 fonts. A Type 1 font that is 30K can be com-
pressed to as little as 7K with the new font format.

Image resampling Distiller offers two methods of 
resampling; downsampling and subsampling. 
Subsampling is faster than downsampling but may 
result in a color shift. See “Using downsampling 
and subsampling to reduce file size” in the Acrobat 
Online Guide for more information.

Advanced options Distiller provides the ability to 
control the printing-specific information main-
tained in a PDF file for use in outputting to high-
end printing systems. See “Choosing Advanced 
Options settings” in the Distiller Online Guide for 
information.

V
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Enhanced viewing features
Acrobat Exchange has been enhanced to integrate 
with Web browsers; open and convert image files; 
provide more flexible display choices; add actions 
to links, bookmarks, pages, and form fields; and 
create and fill out forms.

Integration with the Web

The following new features integrate PDF with 
Web browsers:

• PDF documents can now be viewed directly 
within World Wide Web browser windows that are 
fully compatible with Netscape Navigator 3.0 or 
Internet Explorer 3.0.

• With progressive rendering of text fonts and 
images, the text is rendered first (using a substitute 
font if necessary). Links follow, and then images. 
Any embedded fonts are drawn off screen and sent 
to the screen later, to complete the page drawing.

• The Save As command now includes a checkbox 
for optimizing PDF files for online delivery. Opti-
mization involves consolidation and reordering. 
Duplicate background objects (text, line art, and 
images) are consolidated to significantly reduce 
the file size, and objects in the PDF file format are 
reordered for byte-serving over the Internet. The 
file’s optimize status is indicated in the Document 
Info > General dialog.

• You can easily optimize an entire folder of PDF 
files—and optionally all included subfolders—
using the Batch Optimize command. You can also 
delete or create thumbnails during this batch 
process.

• PDF documents with relative cross-document 
links will now work unchanged. This means you 
can create a single collection of hyperlinked PDF 
files and publish them on local drives, network 
drives, CD-ROM, or a Web server, and all links will 
work in all locations.

• Some Web search tools index PDF documents as 
well as HTML documents on Web servers. Hits in 
PDF files are highlighted within a Web browser 
window.

• PDF documents can be embedded directly in an 
HTML page. See “Using PDF on the Web” in the 
Exchange Online Guide for details.

Opening and converting image files

The Import and Scan plug-ins allow you to create 
PDF Image Only documents from within 
Exchange. The Capture plug-in converts PDF 
Image Only documents to PDF Normal docu-
ments that contain searchable text. See “About 
PDF Document Styles” in the Capture Plug-In 
Online Guide for information about PDF Image 
Only and PDF Normal document types.
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• Use Exchange as an all-purpose image viewer or 
convert images such as TIFF, PCX, BMP, and GIF 
into highly compressed, cross-platform PDF 
image files. No OCR is performed during the 
import process.

• Scan paper documents using a TWAIN- or ISIS-
compatible scanner and view them as PDF images 
in Acrobat Exchange. Or, use the Acrobat link on 
the Visioneer PaperPort desktop to quickly create 
PDF files from scanned images.

• Convert color, grayscale, or black-and-white 
PDF images into small, fully searchable PDF docu-
ments using the Capture plug-in. Using character, 
font, and page recognition, the plug-in can process 
documents in English, French, German, Italian, 
Dutch, Swedish, or Spanish.

New PDF display options

The following new features provide more control 
over the display of PDF documents on-screen.

• New options enable documents to be opened 
with settings suitable for online tutorial, help, and 
kiosk applications. Options include Hide Toolbar, 
Hide Menubar, Center Window On Screen, and 
Resize Window to Initial Page.

• New continuous and continuous-facing page 
layout modes enable continuous scrolling between 
pages.

• Grayscale and color images are automatically 
adjusted for the user’s display to provide more 
accurate display between different monitors and 
systems. Exchange uses ColorSynch on Macintosh 
systems and ICC profiles on Windows systems; if 
neither is present, a default monitor profile is used.

• Exchange provides a new option to smooth the 
display of text and monochrome images, 
improving their legibility on-screen. This option is 
set in the General Preferences dialog.

• Exchange provides new full screen options for 
Default Transitions, Mouse Cursor behavior, and 
disabling the Escape Key Exits.

New action specifications and behavior

To create a truly interactive electronic document, 
Acrobat Exchange automatically initiates some 
actions and also allows you to assign actions to 
links, bookmarks, and form buttons. New actions 
include the following:

• Links to other PDF files open in the same 
window, eliminating the stacking of multiple 
windows in the user’s display.

• You can create buttons and regions in your PDF 
file that perform a variety of actions such as navi-
gating, playing movies and sounds, and executing 
a menu item.

• The New Bookmark command can use the 
selected text as the default bookmark text.



17

• You can duplicate form field buttons on one 
or more pages to facilitate easy setup and editing 
of actions.

Forms

You can use Exchange to create, edit, fill in, and 
print buttons, check boxes, combo boxes, list 
boxes, radio buttons, and text fields. You have 
extensive control over appearance, tab order, and 
behavior. Use Reader to fill in and submit forms.

• You can define actions for when a mouse enters 
or exits a form field, or clicks up or down on a 
form field. Actions can include posting forms data 
in HTML or Forms Data Format (FDF) to the 
Internet. 

• Forms data can also be received from a host 
(Web server). This makes it possible to dynami-
cally update a form and its appearance without 
having to resend the entire form.

• Compared with HTML, Acrobat improves the 
performance of data submittal and archiving. 
Exchange allows you to save and print the field 
data, providing you with a way to archive 
completed forms. Exchange also allows you to 
create form fields that submit only the field data 
and not the form, thus reducing the file transmis-
sion time. See “Setting submit, reset, and import 
form data actions” in the Exchange Online Guide 
for more information.
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Improving Performance 

dobe Acrobat’s performance can be mea-
sured by the amount of time that it takes 
to complete certain operations, such as 

opening a file, sending a file to a printer, or 
redrawing the screen. In part, performance is 
determined by the type of computer and amount 
of memory you’re using. Other factors that can 
dramatically impact Acrobat’s performance are 
how you set up your software, the amount of RAM 
you have, and the size and complexity of your files.

Using RAM to optimize 
performance
The best way to improve performance is to 
increase the RAM installed on your computer and 
allocated to Adobe Acrobat. (Memory allocation is 
done only on the Macintosh.) Deselecting Page 
Cache in your General Preferences helps to 
minimize the amount of memory needed to run 
Acrobat Exchange or Reader, but decreases the 
speed of screen redraw. Deselecting Smooth Text 
and Monochrome Images increases the speed of 
screen redraw, but has no effect on the memory 
requirements.

To increase the memory available to Acrobat 
(Windows):

When an Acrobat component is running, exit 
other applications and close other windows. 

To increase the memory allocation to an Acrobat 
program (Macintosh):

1 Start all applications, except Adobe Acrobat 
Distiller, Exchange, or Catalog, that you will use at 
the same time as those components.

2 Return to the Finder. Choose About This 
Macintosh from the Apple menu. The About This 
Macintosh window appears.

3 Refer to the Largest Unused Block value. This 
value shows the amount of memory currently 
available.

4 Subtract 1 MB to 2 MB of that value for system 
use, and note the result. You will use this result in 
step 6.

5 Select an Adobe Acrobat icon, and choose Get 
Info from the File menu.

6 In the Adobe Acrobat Info window, set the 
Current Size option (or the Preferred Size option if 
you’re working in System 7.1 or later) to the 
amount of memory you noted in step 4.

7 Close the Adobe Acrobat Info window.

8 Follow steps 5-7 for each Acrobat component.

A



19

Managing plug-ins
A plug-in is a piece of software that adds addi-
tional functionality to a base product, such as 
Acrobat Exchange or Reader. Plug-ins increase 
the required amount of memory needed to run 
Acrobat Exchange or Reader.

To minimize the amount of memory needed to 
run Exchange or Reader, you may want to consider 
loading only the plug-ins you use with the pro-
gram. A plug-in must be located in the Plug-ins 
folder within the Acrobat3\Exchange (Windows) 
or Adobe Acrobat 3.0 (Macintosh) folder to load 
with the program. If the plug-in is moved to 
another location, it will not load with Exchange or 
Reader. Alternatively, you can temporarily disable 
all plug-ins when starting Acrobat Exchange or 
Reader.

To disable a plug-in:

1 Open the Plug-ins folder in the Exch16 
(Windows 3.1 and later) or the Exchange 
(Windows 95, Windows NT 3.5.1 and later, or 
Macintosh) folder. 

2 Select the plug-ins you do not want to load.

3 Move the selected plug-ins to the Optional 
folder in the Acrobat3\Exch16 (Windows 3.1 and 
later), Acrobat3\Exchange folder (Windows 95 
and Windows NT 3.5.1 and later), or the Optional 
Plug-ins folder in the Adobe Acrobat 3.0 
(Macintosh) folder.

To temporarily disable all plug-ins:

Hold down the Shift key immediately after you 
start the Exchange or Reader program icon.

To increase the processing speed of the Capture 
plug-in:

Do one or more of the following:

• Add more RAM than the required 16 MB.

• In Window 3.1 and later, have the required 
16 MB of RAM available and create a permanent 
swap space of 25 MB + the size of the largest 
uncompressed image you will process (twice the 
size is even better). (Refer to a Microsoft Windows 
manual for information about creating a perma-
nent swap space.)

• In Windows 95, have the required 16 MB of 
RAM available and free disk space equal to twice 
the size of the largest uncompressed image you will 
process.

Managing Acrobat Catalog
To build an index with Acrobat Catalog, you need 
enough free disk space to accommodate the index 
files, plus enough free disk space for the temporary 
files created during the build. Also, the amount of 
RAM available for Catalog affects the speed with 
which indexes are built and determines how large 
a document can be without requiring segmenta-
tion for the purpose of indexing.

For more information, see the Catalog Online 
Guide.
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Managing search indexes in 
Exchange and Reader
You can add full-text indexes created by the 
Acrobat Catalog program to Exchange and Reader. 
These full-text indexes allow you to search a collec-
tion of PDF documents. Each index you add to 
your search list requires approximately 50K of 
memory. To reduce the amount of memory 
required to run Acrobat Exchange or Reader, 
limit the number of indexes you have loaded at
any one time and remove indexes that you use 
infrequently.

Improving printing performance
To improve printing performance to a PostScript 
printer, use the Adobe printer driver. See “Install-
ing the Adobe Printer Driver” for installation 
instructions.
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Installing the Adobe printer driver in 
Windows

o create the most efficient PostScript 
files for converting to PDF with Acrobat 
Distiller, you should use the Adobe 

PostScript printer driver.

This section explains how to install the Adobe 
printer driver in Windows 3.1 and later and Win-
dows 95. The Adobe printer driver is not available 
for Windows NT. The Setup program contains 
online help for further details.

To install the Adobe Printer Driver program:

1 Insert the Adobe Acrobat CD-ROM into your 
CD-ROM drive.

2 Exit all applications. To do so, use the Alt-Tab 
option to move through and exit the running 
applications.

3 Follow the instructions for your Windows 
version:

• In Windows 3.1 or later, open the drivers\win31 
folder on the CD-ROM.

• In Windows 95, open the drivers\win95 folder 
on the CD-ROM. 

4 Follow the instructions in the ReadMe file 
within the opened folder to continue the installa-
tion of the driver. 

5 Follow the instructions in “Creating PostScript 
files” in the Distiller Online Guide to set up the 
driver with the Acrobat Distiller PostScript Printer 
Description (PPD) file. Using the Acrobat Distiller 
PPD will ensure that you get the most efficient 
PostScript file for converting to Portable Docu-
ment Format (PDF) with Acrobat Distiller.

T
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Installing the Adobe printer driver 
on a Macintosh

o create the most efficient PostScript files 
for converting to PDF with Acrobat Distiller 
and to use the Acrobat Distiller Assistant 

utility, you should use the Adobe PostScript 
printer driver.

Distiller Assistant makes it possible to print 
directly to Acrobat Distiller so that you can create 
PDF files in one easy step. See the Distiller Online 
Guide for more information about Distiller Assis-
tant.

This section explains how to install the Adobe 
printer driver on your computer and how to set up 
the driver to work with your printer. See “Creating 
PostScript” in the Distiller Online Guide for step-
by-step instructions for setting up the Acrobat 
Distiller PPD.

Along with the driver that you install on your hard 
disk, you install PostScript Printer Description 
files (PPDs). At a minimum, you should install 
one PPD for any printer you use and one for use 
with Acrobat Distiller. (The Acrobat Distiller PPD 

is copied to the Xtras folder in the Adobe Acrobat 
3.0 folder as part of the Acrobat installation. 
Therefore, you do not need to copy it to your hard 
drive again.) Later, when you set up the driver with 
a printer or with Acrobat Distiller, you will associ-
ate the driver with its PPD.

To install the Adobe printer driver program:

1 Insert the Adobe Acrobat CD-ROM into your 
CD-ROM drive. Open the PSPrinter 8.3.1 folder 
inside the Drivers folder.

2 Double-click the ReadMeFirst file and read the 
document for the latest information on your 
Adobe Printer Driver product. When you are 
finished, choose Quit from the File menu.

3 Remove or turn off any virus protection 
software.

4 Double-click the Installer program icon. The 
splash screen and then the Adobe Printer Driver 
Installer dialog box appear.

T
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5 To begin the installation process, choose one of 
the two options:

• To install all possible PostScript Printer Descrip-
tion (PPDs) files on your hard disk along with the 
driver, click Install. You must have at least 16.5 MB 
of available disk space to install all PPDs.

• To conserve disk space and install only the PPDs 
specific to your printer manufacturer or printer 
family along with the driver, click Customize.

In the Customize dialog box, choose PSPrinter 
(the driver) and the names of the manufacturers of 
printers whose PPDs you wish to install. You can 
also choose ReadMe if you wish to install and read 
that file later. Once you have chosen all the items 
you wish to install, click Install.

Note: Adobe recommends the Customize procedure 
because it conserves disk space by letting you install 
only the PPDs you need now. If your needs change, 
you can install other necessary PPDs later.

6 If other applications are running, the Installer 
displays another dialog box asking whether 
you want to continue. To continue and quit all 
running applications, click Continue. No other 
applications can be running when you install 
new software.

The Installer copies the Adobe printer driver and 
the Printer Descriptions folder (for PPD files) into 
the Extensions folder of the System Folder. It cop-
ies the ReadMe file to the top level of your hard 
disk. If required, the Installer copies the new 
version of the Chooser into the Apple Menu Items 
folder of the System Folder.

7 Replace or turn on any virus protection 
software that you removed in step 3.

8 Restart your Macintosh.

Setting up the driver to work 
with your printer 
Next, you need to select a printer and set up the 
driver to work with the selected printer. To set up 
the driver, you select a PPD file to use with your 
printer. The driver uses the information in the 
PPD file to give you control of all your printer’s 
features.

See the USRGUIDE.PDF file located on the Adobe 
Acrobat CD-ROM in the PSPrinter 8.3.1 folder 
inside the Drivers folder for more information.
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Installing and Using Adobe Type 
Manager in Windows

dobe Type Manager (ATM) is a font util-
ity that generates sharp, clear characters 
of any size on-screen and on non-Post-

Script printers.

ATM is not required to use any of the Acrobat 
components, but you may want to install it for 
these reasons:

• ATM gives you access to Type 1 fonts in all your 
Windows applications regardless of what printer 
driver you have chosen.

• For this reason, you can avoid using TrueType 
fonts (using Type 1 fonts in all cases) in PDF files 
created with Acrobat Distiller. This is preferable, 
because when such files are created in Windows 
with TrueType fonts the text in them is unsearch-
able and unselectable.

• If you use Type 1 fonts in your documents and 
want to embed those fonts in your PDF files with 
PDF Writer, you need ATM. 

By default, the ATM installer program installs the 
ATM software into your \Windows and \Windows 
\System folders, and it copies the font files to your 
\psfonts and \psfonts\pfm directories. Installation 
also modifies the SYSTEM.INI file, creates or 
modifies the ATM.INI file, and may modify the 
WIN.INI file if you have a PostScript printer on 
your system. See the file TECHREF.WRI (included 
with ATM) for more information about the con-
tents of .INI files and other files that ATM uses.

You do not have to disable virus-checking 
programs in order to install ATM.

To install the ATM software on your system:

1 Insert the Adobe Acrobat CD-ROM disc into 
your CD-ROM drive.

2 Follow the instructions for your platform:

• In Windows 3.1 or later, choose the Run 
command from the File menu in Program 
Manager.

• In Windows 95, choose the Run command from 
the Start Menu.

A
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3 Type d:\atm302\install (where d: is the letter of 
the drive containing the CD-ROM disc), and click 
OK. The ATM Installer appears.

ATM installer. Click Browse to examine the 
directory structure.

4 Accept c:\psfonts as your PostScript outline 
software directory, or enter a different directory 
name. By default, the Installer places the font 
metric directory within the outline font directory 
you choose.

5 Click Install.

6 When prompted, restart Windows to use the 
ATM program. When you upgrade, ATM Control 
Panel settings such as installed fonts are preserved.

Note: If you attempt to install an older version of 
ATM over a newer version, the installer program 
warns you and gives you a chance to click Cancel 
before it continues.

Adding and removing Type 1 
fonts
 ATM lets you add or remove fonts and includes 
several options.

To open ATM:

1 Follow the instructions for your Windows 
platform:

• In Windows 3.1 or later, open the Main program 
group, and double-click the ATM icon to display 
the ATM Control Panel.

• In Windows 95, choose Start > Programs > 
Adobe > Adobe Type Manager.

It is best to use the ATM Control Panel to install 
Type 1 fonts. Font installers provided with Type 1 
fonts typically install fonts for use only on 
PostScript printers. In contrast, the ATM program 
installs Type 1 fonts for use with PostScript 
and non-PostScript printers, and it provides a 
WYSIWYG (what-you-see-is-what-you-get) 
screen display.
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To add Type 1 fonts:

1 Open ATM.

2 Click Add. ATM displays the Add ATM Fonts 
dialog box.

3 Use the Directories list box to locate the desired 
fonts. The Source Directory field indicates the 
current directory and pathname, and any fonts in 
that directory appear in the Available Fonts list 
box.

4 Do any of the following:

• Select the Install Without Copying Files option 
to update your ATM.INI and WIN.INI with the 
names of the font files but not copy their files. This 
is useful if you use a large number of fonts from a 
CD-ROM or network drive. 

• Select the Autodownload for PostScript Driver 
option to install the font and update the WIN.INI 
file so that Windows downloads the font to your 
PostScript printer each time you print a document 
that uses the font. This option is selected by 
default; however, if you manually download a font 
to the printer, uncheck this box so that Windows 
does not download the font with every print job.

• Click Browse to select a target directory for the 
PostScript outline fonts and the font metric files. 
Adobe recommends the default settings for these 
directories.

5 Select the names of the fonts you want to add. 
Click to select one font, Control-click to select 
several individual fonts, or Shift-click to select (or 
deselect) a group of fonts.

6 Click Add. When ATM has finished adding the 
selected fonts, it closes the Add ATM Fonts dialog 
box. The fonts are then available for use in your 
applications.

Removing fonts

You may wish to remove a font that you no longer 
use. You can either remove it completely from your 
hard disk or just remove it from Windows while 
leaving the font files on the disk. If you remove a 
font completely, you will have to reinstall it later 
from the original source disk.

To remove fonts from your system:

1 Open ATM.

2 Select the names of the fonts you want to 
remove. Click to select one font, Control-click to 
select several individual fonts, or Shift-click to 
select a group of contiguous fonts.
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3 Click Remove. ATM displays a confirmation 
dialog box.

4 Click Yes to remove the font. To remove the 
remaining fonts without confirming removal of 
each font, click No Confirmation to Remove 
Fonts. To delete fonts from the disk, click Delete 
Fonts from Disk.

Selecting ATM options
The ATM program gives all your Windows appli-
cations a WYSIWYG display for Type 1 fonts.

To select ATM options:

1 Open ATM.

2 Select an ATM option as follows:

• Click On or Off to turn the ATM software on and 
off. When ATM is on, it displays Type 1 fonts on-
screen and sends Type 1 fonts to your printer (even 
to non-PostScript printers). When ATM is off, 
only non-Type 1 fonts appear on-screen. Type 1 
fonts print correctly on a PostScript printer if you 
have installed the fonts, but Windows substitutes 
another font for screen display and for printing on 
a non-PostScript device.

• Adjust the Font Cache setting to determine the 
amount of system memory used to store font data 
created by ATM. The default cache size is 256K. 
Adobe recommends a minimum of 256K for 
computers with 4 MB of memory and an addi-
tional 64K for each additional megabyte of 
memory. To change the font cache, click the up or 
down arrow.

• Select Use Prebuilt or Resident Fonts to tell ATM 
to use bitmap fonts that reside in Windows and to 
use fonts that reside in the printer, if they are avail-
able. Using prebuilt or resident fonts can help your 
applications display and print documents more 
quickly.

• Select Print ATM fonts as graphics to tell the 
ATM program to send fonts to the printer as 
graphic images and not to use downloadable fonts. 
If your PCL printer (such as an HP LaserJet printer 
and various clones) does not support download-
able fonts, or if a document with mixed text and 
graphics does not appear to print correctly, 
checking this box may help. Printing time may 
increase slightly.
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3 Click Exit. Either restart Windows or return to 
your current Windows session. If you have turned 
ATM on or off, or changed cache size, you must 
restart Windows for your changes to take effect.

Removing the ATM program
from your system
You can remove the ATM program from your sys-
tem by deleting several program and font files and 
by editing the SYSTEM.INI file.

To remove ATM from your system:

1 Use ATM to remove Type 1 fonts from your 
system. Delete them from the hard disk. 

2 Make a backup of the SYSTEM.INI file in your 
\Windows directory. Name it something that does 
not conflict with an existing file.

3 Use Notepad or another text-editing program to 
open the SYSTEM.INI file.

4 Remove the following two lines, which are 
located in the BOOT section of the SYSTEM.INI 
file:

system.drv=atmsys.drv
atm.system.drv=system.drv

Replace the two removed lines with this single line:

system.drv=system.drv

Note: If you are using an HP Vectra machine, the 
line should read

system.drv=hpsystem.drv

See the file TECHREF.WRI for more information.

5 Save the SYSTEM.INI file as a plain text file. 
(The Notepad program does this automatically.)

6 Quit Notepad, and exit Windows.

7 Delete ATM16.DLL, ATM32.DLL, and 
ATMSYS.DRV from your \Windows \System 
directory. If you have had ATM version 1.x on your 
system, you may also need to delete ATM.DLL.

8 Delete ATM.INI and ATMCNTRL.EXE from 
your \Windows directory.

9 Delete the ATMFONTS.QLC file from the direc-
tory that contained the .PFB files. The default 
directory is \PSFONTS.
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Installing and Using Adobe Type 
Manager on a Macintosh

dobe Type Manager (ATM) is a font 
utility that generates sharp, clear 
characters of any size on-screen and 

on QuickDraw printers.

The Adobe Acrobat package includes ATM 4.0 
software for the Macintosh. A version of ATM that 
affects only Acrobat Exchange or Reader, called 
loadable ATM, is installed during the default Acro-
bat installation. However, if a version of ATM that 
is older than the version that comes with Acrobat 
is already installed at the system level, the Acrobat 
installer will update system ATM. If you wish, you 
can also custom-install system ATM.

ATM needs to be installed at the system level if you 
want to embed Type 1 fonts in your PDF files using 
PDF Writer.

To install the ATM software on your system:

1 Insert the Adobe Acrobat CD-ROM disc into 
your CD-ROM drive.

2 Open the Exchange folder inside the Adobe 
Acrobat 3.0 folder and double-click the Exchange 
3.0 installer icon.

3 The Adobe Acrobat Exchange Installer dialog 
box appears. Follow the instructions on-screen to 
progress through the introduction and accept the 
license agreement.

4 Choose Custom Install from the pop-up menu.

5 Select the following items:

• Install ATM 4.0 in the System Folder

• Install required fonts in the System Folder

6 Click Install.

7 Restart your computer when prompted to do so.

Selecting ATM options
The ATM Control Panel includes options for turn-
ing ATM on and off, changing the font cache size, 
and determining how character shapes and line 
spacing appear when you use various applications.

To select ATM options:

1 Choose Control Panels from the Apple menu. 
The Control Panels window appears.

A



ADOBE ACROBAT 3.030
Installing and Using Adobe Type Manager on a Macintosh

2 Open the ATM Control Panel by double-
clicking the ATM icon in the Control Panels 
window.

Note: The Substitute for Missing Fonts option is 
dimmed unless you have installed the ATM font 
database that comes with Super ATM.

3 Select ATM options as follows:

• Click On or Off to turn the ATM software on and 
off.

• Adjust the Font Cache to set the amount of 
system memory available to store bitmap charac-
ters created by the ATM program. The default 
setting is 256K. Adobe recommends a font cache of 
at least 512K.

• Select the Preserve Line Spacing option to 
reduce the size of accented characters so they fit 
within the current line height and retain the same 
line and page breaks within a document. This 
option is selected by default; however, this option 
may clip the descenders of some characters.

• Select the Preserve Character Shapes option to 
maintain the size of accented characters and 
increase the size of the current line height to 
accommodate the larger characters.

• Select the Smooth font edges on-screen option 
to improve the appearance of Type 1 fonts on-
screen by smoothing out the jagged edges inherent 
in video displays. Using this feature can slow down 
type-intensive displays on some systems. In that 
case, try increasing your font cache.

• Select the Precision Character Positioning 
option to position characters at the sub-pixel level 
to display more accurate spacing, especially at 
small point sizes. Selecting this option may slow 
down type-intensive display on some systems. Not 
all applications support sub-pixel positioning.

• Select the Enable Font Substitution option to 
instruct ATM to create replacement fonts from 
available Type 1 fonts if the original font is 
missing.

Note: If you own Multiple Master fonts, you can use 
the Create MM instances feature. See your Adobe 
Type Library User Guide for details. 

4 Choose Restart from the Special menu. You 
must restart your Macintosh for changes to the 
ATM Control Panel to take effect.


